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Part 1: Getting Started

This is a documentation about the social bookmarking platform SemanticScuttle. It is divided
into three parts. The first part of this manual is reserved for novices to the field. They may
learn about the basics of social bookmarking: what is a bookmark, what is a tag, how can tagging
help? The second part explains the everyday use cases of SemanticScuttle. Experienced web
users may understand SemanticScuttle without these explanations. The third part is for
advanced users and administrators.

About SemanticScuttle

SemanticScuttle is a open-source social bookmarking web application. A social bookmarking
tool like del.icio.us, Mr. Wong, or StumbleUpon allows users to collectively bookmark web pages
indexing them with tags (i. e. terms freely chosen).

Each user has his own bookmark collection. He can add new ones, modify existing, remove
obsolete ones, and export them for later use. All individual bookmark collections together result
in a large pool of knowledge.

SemanticScuttle is based on Scuttle'. SemanticScuttle explores new exciting features that enrich

the interconnections between the semantic structures of the bookmarks. Some of these new
features are:
» Each bookmark and tag may be given a public description. Every user is able to modify
this description until the bookmarking community agrees on one meaning.
* The user may define relations between tags (inclusions; see page 16)
» The user may also define synonyms. Every user has his own ideas about the ideal tags for
a bookmark. The synonyms make it possible to find all bookmarks with a certain meaning,
even if different words are tagged (see page 16).
A second advantage of SemanticScuttle is that it may be freely used on any server for any
purpose. Any community may set up its own bookmarking service. A book club for example may
share bookmarks about creative writing and literature.

1 an open-source clone of Del.icio.us whose development is frozen today.



http://sourceforge.net/projects/scuttle/
http://sourceforge.net/projects/scuttle/
http://sourceforge.net/forum/forum.php?forum_id=749062
http://del.icio.us/

Basic Concepts

Bookmarks

A bookmark is a reference to any web resource. In

Bookmark

SemanticScuttle a bookmark is composed of: User A

* URL (i.e. the address of the resource in the web) of =

the bookmark (mandatory) B°3!§T§ i

» Title and description
. N
* Personal title (mandatory) Bookmark

» Personal description User C

» A private note. This is a description only visible to the owner
» Private description which only visible to friends (see sections about Privacy and
Watchlists).
* Tags
» Privacy setting that defines who is allowed to see the your bookmark. The default setting
is "public”.
While the web resource exists only once, a bookmark may be owned by several users. To make it

more confusing, each user may give that bookmark an individual title, description, and tags. The
"identity” of the bookmark however is set by the web address.

Tags

A tag is a keyword assigned to a bookmark. Tags are chosen arbitrarily and personally by the
creator of a bookmark.
Tags are crucial in social bookmarking. Tags have several purposes:

* They add information to the bookmark. This information facilitates the search.

* They add a structure to the bookmarks of several users. Bookmarks that share tags are

supposed to be more similar than others. This leads to clusters of bookmarks.

From this bookmark clusters another property develops. The user can "brachiate” from tag to tag
and - in doing so - detect further interesting resources. The advantage is that you do not need to
know the specific names of these tags.




steak tartare

Honey Peanut butter
Meat paste
Bread
/ Sausage
Butter
Marmelade
Cheese
Figure 1: Two clusters of tags
A list of tags is often depicted as tag cloud. In such a tag cloud ecent tags
the tags are listed alphabetically. The frequency of a tag is shown
with its font size. Thus both finding a tag by alphabet and by ACNE wcneocne beauty  blog
popularity is possible. You may click on a tag in the cloud. This business card CATE care,acne

care,beauty computer credit

CUrrency  decor forex

health home hompage  erstellen

will open a new list of bookmarks which all carry the clicked tag.
SemanticScuttle uses different kinds of tag clouds. The recent

tags are those tags the users have recently defined. They give you .
products products,acne Sk]n

information about the topics people are currently interested in. .
Sk]n,acne skin,skin  system

The menu tags are tags featured by users (see section Menu

trader,forex tradi ng
Tags). The popular tags are those that users most frequently trading, forex
assign to their bookmarks. treatment treatment,acne

treatment,beauty vour
Anchors

Popular Tags —

SemanticScuttle uses anchors to format the description of a Figure 2: A tag cloud showing
bookmark. Any user-defined anchor is possible but (as those tags users have recently

recommended by SemanticScuttle) the most useful information  searched for.

may be: author, address, and a description.

The following example shows a bookmark with three anchors: an author, a description, and
an anchor named user-defined. You may define those anchors in the description field when
you specify the details of a bookmark (see Add a Single Bookmark or Edit bookmarks).




Fote Zwiebeln vom Grill

author Max Mustermann

description This recipe for grilled onions is ideal as an accompaniment to grilled meat, The sweet
pungency of the onions harmonizes excellently,

This is text without an anchar,

user-defined user-defined description

http:/ fweew huettenhilfe,de/ rezept-rote-zwiebeln-vom-grill_2498. himl
by wou - Edit - Delete {10-06-2009)

Figure 3: Example - bookmark with three descriptions anchors: author, description, and
user-defined.

Privacy and Watchlists

SemanticScuttle allows three levels of privacy. Firstly, each user can grant access to a bookmark
to everyone (setting "public”). All users can see this bookmark. Secondly, each user can have
private bookmarks. A private bookmark can only be accessed by the owner.

Thirdly, SemanticScuttle knows watchlists. Users can set other users to their watchlist. All the
people you set on your watchlist are considered as "friends”. You can grant them access to
certain bookmarks that no-one else can see (see Figure 4).

* Like all users, watchlist users can see all public bookmarks.
¢ Watchlist users also see bookmarks that are restricted the "all users from the watchlist".

* But no one can see the private bookmarks. An exception to this rule are the
administrators of your SemanticScuttle installation, provided that your SemanticScuttle
installation grants them the necessary rights (see more in Users Groups, below).

user  public \ other user
—00O
watchlist \
— 99
watchlist -
() user on watchlist
> .
private

Figure 4: A user on your watchlist can see more

bookmarks.




Users Groups

There is the administrator of SemanticScuttle. But "above” this admin there is also the
administrator of the web server. Finally, there are the users (see Figure 5). All users are equal,
but administrators have more rights (of course). Only an admin of the web server may promote
someone to admin of SemanticScuttle. They also set the basic configuration of SemanticScuttle.
This includes the definition of featured menu tags (see Menu Tags, below).

The SemanticScuttle admins have certain privileges:
* The SemanticScuttle admin may define e. g. menu tags (see Menu Tags, below).

* They can see and edit all bookmarks of all users. If a web server admin has set the
according configuration this includes private bookmarks (see Configure, below).

* They can remove a user from SemanticScuttle (see User and Bookmark Administration,

below).

* They can validate bookmarks (see User and Bookmark Administration, below).

. Web Server User /\
<l <
Admln Semantic
Scuttle
Admin/
00—,

Figure 5: Different roles in the infrastructure of
SemanticScuttle




SemanticScuttle Documentation

Part 2: Everday Tasks

How to Enter SemanticScuttle

When you access SemanticScuttle it welcomes you with a page as depicted in Figure 6.

ﬁ semanticscuttle populartags about register log in

all bookmarks Search.. allbookimarks |« || search I

last searches
I Welcome to SemanticScuttle! A social bookmarking tool for small communities. I
description (1)
yahoo (1)
2 bookmark(s) - Sort by: (AR (AN [FORET
= — featured menu tags
= Yahoo
http:/fyahoo.com last users

Tags: search, Usa, test by admin (11.02.2009)

admin (bookmarks)

Google Google 17

—_— All users —
Google description

http://google.com

Tags: search by admin ittaz20s)

Firet | [Tereviste | et Flast page of1

Propulsed by Semanticscutte (thumbnls by 3rtviper designstudic}

Figure 6: The welcome screen of SemanticScuttle.

The most important areas are the headline and the main area. They are always present.
* The headline is mainly used for navigation and search.

e The main area provides means to complete any kind of task. In most cases, the main area
displays a list of bookmarks. But you may also define nhew bookmarks or edit your profile

* The side bar is only used when the main area displays bookmarks. It displays tag clouds.

semanticscuttle popular tags about register log in
Headline

all bookmarks Search. .. all buukmarks‘VI Search

Welcome to SemanticScuttle! A social baokmarking tool for small cammunities.

4
2 bookmark(s) - Sort by: --- B

Yahoo &

http:# /vahoo.com

Tags: search, usa, test by admin (wnmﬁin area [ S]ide bar

Google. Google &

e Google description

http:#/ gongle.com

Tags: search by admin (11-0z-200%)

First Pravious MNext Lo Pageloft

Propulsed by Semanticscuttie (thumbrals by artyiper designstudia)




Registration

ﬁ semanticscuttle popular tags about register login
all bookmarks Search... 0l all bookmarks ~

last searches

Welcome to SemanticScuttle! Social bookmarking for small communities.

touch (2)

Click on the item "register”.

The following form opens (Figure 7). You need to enter a user name, a password, an e-mail
address.

* This is the name that identifies you on SemanticScuttle. Your user name must meet the
following conditions:

o it is not being used by someone else.

o it is not a reserved user name (which are usually the names "watchlist" and "all"). In
any case, SemanticScuttle will feed you back if you have to select another user name.

o it must be between 4 and 24 characters long.

o it must not contain special characters. Allowed are letters, underscore, and digits.

* The password must be at least 6 characters long. Apart from that, it may be chosen
freely. For your own safety, please use a password with upper, lower case letters, and
even special characters.

* The e-mail address is important if a user forgets his password. Without an e-mail address,
the admin cannot send him a new one.

Finally, answer the antispam question, click "register” and you are in.

ﬁ semanticscuttle popular tags about register log in

register

Sign up here to create a free SemanticScuttle account, All the information requested below is required.

Username wenzel
Password sssssssss
E-mail lisa.wenzel@uid.com
Antispam question | sermanticscuttle

Figure 7: The registration form




Login

To log in enter user name and password and confirm with the button "Log in" (see Figure 8). If
you check the switch "Don't ask for my password for 2 weeks", SemanticScuttle will save a cookie
on your computer. With this cookie the manual log-in may be avoided for two weeks.

Usaernaine testuser

Password LT L] pon't ask for my password for 2 weeks,

» Forgotten your password?

Figure 8: The log-in screen

If you have forgotten your password, SemanticScuttle can generate a new one. Click "~ Forgotten
you password”. A new form opens. Now enter user name and e-mail address of your account and
SemanticScuttle will e-mail your new password to you.

Your Profile

Account Details

Username  jseifert

New Password |esssssssss
Confirm Password

E-mail |jan.seifert@uid.com — Required

Figure 9: The account details of a profile specify your SemanticScuttle
identity.

On each page of SemanticScuttle is a link to your profile (see e. g. Figure 11). Each profile
comprises two groups of information.

The account details that give you a unique identity in SemanticScuttle. These data is not visible
to other members.

The personal details are optional. They are useful to tell something about yourself and
especially your interests. Other members of SemanticScuttle can see your personal details. They
can evaluate whether they share your interests and may look in your collection for other
interesting bookmarks they do not yet know of.




Personal Details

Name | Jan Seifert (JAS)

Homepage | http://192.168.0.201/uid/teamworks.dllfemployees/employees/Employee_Pa

Description

Save Changes

Figure 10: The personal details are not mandatory. You may edit something
to tell a little bit more about yourself.

Add a Single Bookmark

N\
ij semanticscuttle bookmarks tags watchlist profile PELLEENLTTTL S
about ‘h wenzel (log out)
my bookmarks Search... 0 vy bookrmarks [V]

Mo bookmarks available ‘

Figure 11: The view on your collection after registration. You do not yet have any bookmarks.

You must be logged in to enter new bookmarks. If you are, you may simply click on "add" and the
a form opens (see Figure 12). In this form you define (from top to bottom) the web address, the
bookmark title, a description, and a few tags. You may simply add tags by clicking on the items
in the tag cloud below the form.

Optionally a private note can be set. This hide behind the link "Add Note" behind the label of the
description (Figure 12 does not show this, here the private note has already been opened).
Finally you may want to change the privacy setting to something different than "public”. When
you are finished, "Save Changes" will save the bookmark to your collection.




Address | http:/ fwwaw huettenhilfe.de/ rezept-rote-zwiebeln-vom-gril_2498. html

Title | Rote Zwisbeln vam Grill

[author]tax dMustermannlf author]

[description]This recipe for grilled onions is ideal as an
accompaniment to grilled meat. The sweet pungency of the
onions harmonizes excellently. [/ description]

This is text without an anchor,

[user-defined]user-defined description[/user-defined]

Description

Private Mote

Tags
Mote: use "+ to include one tag in another. &.2.; suroperfrance paris
Mote: uze =" to make symonym two tags. .2, france=frenchoountry

Privacy | Public |v

| Save Changes | | Cancel | | Delete Bookmark | [edit common description]

Figure 12: The form to enter a new bookmark.

Import Bookmarks

You may already have a big collection of bookmarks. To enter these one by one would be rather
cumbersome. For this reason, SemanticScuttle has an import function.

Import

® |mport bookmarks from bookmark file {Internet Explorer, Mozilla Firefox and Netscape)

e Import bookmarks from del.icio.us
Figure 13: The access to the bookmark import is available using "add a bookmark".
Adding bookmarks is quite simple. You need a file with your bookmark collection. Click "add a
bookmark" in the header of SemanticScuttle and open the "add" page. Two links are available at
the bottom of the page (see Figure 13).

File fhame(jan/Desktopjtest html

Privacy | pyblic |
Figure 14: Import bookmarks from a file

You may import bookmarks from two sources:

Browser import. Web browsers use a HTML file to store exported bookmarks. Importing
bookmarks from the browser unfortunately omits the complete folder structure. Unless you have
defined tags, your bookmarks will not have any tags. You need to go through them one by one
and define the tags. If you cannot tell, which bookmarks are still without a tag, you may search
for these orphans (see Orphans: Untagged Bookmarks, below).




Del.icio.us import. del.icio.us uses XML files to backup bookmarks. SemanticScuttle can import
these XML files.

You have already submitted some of these bookmarks.

Bookmarks found: 679 Bookmarks imported: 652

Privacy | public |

Figure 15: Successful import of bookmarks. Still, SemanticScuttle refused to import some of the

bookmarks because they were already in the collection.

Edit

Any bookmark may be changed. You can edit a bookmark when you click "Edit" in the list.

Fote Zwiebeln vom Grill

author Max Mustermann

description This recipe for grilled onions is ideal as an accompaniment to grilled meat, The sweet
pungency of the onions harmonizes excellently.

This is textwithout an anchar.

user-defined user-defined description

http: s fwenan huettenhilfe, des rezept-rote-mwiebeln-vorm-grill_24 98 html
by wou - Edit - Delete (10-06.2009)

Figure 16: The link "Edit" in the last line lets you change the bookmark. Clicking "Delete”
lets you remove it from your collection.

Delete

If you want to remove a bookmark from the collection, you simply click on "Delete” in the last
line of a bookmark. A confirmation prompt appears. If you confirm, SemanticScuttle
immediately removes the bookmark. This action cannot be undone!

Export Bookmarks

You may save all your bookmarks at any time.

Click "Profile” in the header of SemanticScuttle. At the bottom of the profile page are the links
to the export (see Figure 17). Three options are available:

* Using HTML you may import the bookmarks into your browser and re-import them into
SemanticScuttle later. SemanticScuttle will display the result directly in you web
browser. Use the "Save as ..." entry in the file menu to store the export on your computer.




Using an XML file saves your bookmarks in a file format defined by del.icio.us. It is
possible to import the file to del.icio.us or to any SemanticScuttle server.

A CSV file is only interesting for a spreadsheet software like Microsoft Excel™ or
OpenOffice Calc. It exports a table-like output.

Aktionen

Favu_nten HTML Datei (fir Browser) f XML Datei (wie del.icio.us) £ C5V Datei [fir Tabellenkalkulationsprogramme)
exportieren =

Figure 17: Exporting bookmarks. The user may choose between three different output formats.

Export Bookmarks from other Sources

Export Bookmarks from the Web Browser. If you want to import your browser bookmarks into
SemanticScuttle, you have to "get your hands on them".

1.

3.
4.

Export your bookmarks from your browser to a file:
o Internet Explorer: File > Import and Export... > Export Favorites
o Mozilla Firefox: Bookmarks > Manage Bookmarks... > File > Export...

o Netscape: Bookmarks > Manage Bookmarks... > Tools > Export...

Click Browse... to find the saved bookmark file on your computer. The maximum size the
file can be is 1MB.

Select the default privacy setting for your imported bookmarks.

Click Import to start importing the bookmarks; it may take a minute.

Export Bookmarks from Del.icio.us. If you have an account on del.icio.us you may save your
bookmarks on your computer before you re-import them to SemanticScuttle.

1.
2.

3.

Log in to the export page at del.icio.us.
Save the resulting XML file to your computer.

Click Browse... to find this file on your computer. The maximum size the file can be is
1MB.

Select the default privacy setting for your imported bookmarks.

Click Import to start importing the bookmarks; it may take a minute.




Tagging

Without tags social bookmarking would not work (see Tags, above). Each bookmark shall have
tags. When you add a bookmark you can also add any number of tags. Tags are separated by
commas. You may use space in tags.

Hierarchical relations: Inclusions

Anyone can define hierarchical relations. When you define a bookmark you may — Europe

create the inclusion "en passant”. -~ Belgium
Let us have a look at the following examples: France
Europe>France>Paris, Monument>EiffelTower, Red " Paris
As a result the description under the bookmark will be the final tags in case of L Lyon
inclusion (i.e. the leaves of the tree). In this example, it will be: Paris, Germany
EiffelTower, red. The resource can be found through these tags. L Berlin

Nevertheless, thanks to the inclusion link, the resource can also be found if you —@ain

look for Europe, France Or Monument. Barcelona

Once the inclusion has been established, SemanticScuttle will not forget it. Monument
Imagine you tag a second resource about the Sacré-Coeur. You add the tags: L EiffelTower
Paris, Monument>SacreCoeur. The system will automatically create the

— Monument
following inclusions: Monument includes SacreCoeur. Even if you have not _

—— EiffelTower
specified for this resource, that Paris is in France which is in Europe, the

—— SacreCoer

system remembers that relation. There are links of inclusion between these
tags (cf first resource). Finally, this second resource can be found with the tags Europe,

France, Paris, Monument and SacreCoeur.

Synonyms

Anyone can define synonyms. When you define a bookmark you may create a synonym "“en
passant”.

Some users may use tags in singular others in plural. But all users associate the same meaning
with this tag. So it is reasonable to define e. g. recipe = recipes. In other cases, some users
may use English tags while their co-users stick to their native language. In this case it may be
reasonable to set e. g. recipe=Rezept (With "Rezept" being the German word for recipe).

Related Tags

Related tags are not yet implemented.




Menu Tags

SemanticScuttle allows a special type of tag. They are called menu tags. These tags are
displayed on the right side of the SemanticScuttle page. There are two different kinds of menu
tags:

* The common menu tags. The default menu tag is "menu”. When you include a tag
schnitzel into the menu tag (menu>schnitzel) then schnitzel will appear in a menu in
your page. Only SemanticScuttle admins may define common menu tags.

* The featured menu tags include keywords that are proposed and organized by the
administrators. A server administrator can define these tags in the file config.inc.php
(see section Configure, below).

Orphans: Untagged Bookmarks

For the maintenance of your bookmarks it is important to find bookmarks without a tag. If there
is a bookmark without a tag, SemanticScuttle automatically assigns a "secret” tag to all
bookmarks that do not have another one. This secret tag is named system:unfiled. It allows
you to find bookmarks without tags.

Explaining and Maintaining Tags

In SemanticScuttle you may not only use tags. You may also write a few sentences about the tag
to explain it in more detail.

You have access to all maintenance functions for tags, when SemanticScuttle displays the
bookmarks of this tag. You receive those e.g. by clicking on the tag in the tag cloud. At the top
of the page are two options for a personal and a common description of that tag.

Edit the common description of this tag #

Edit your personal description of this tag #

1 bookmarl(s] - Sort by: | Date Title URL - EBookmarks fram other users for this tag

Rote Zwisbeln wom Grill

author #ax Mustermann

description This recipe for grilled onions is ideal as an accompaniment to grilled meat. The sweet
pungency of the onions harmonizes excellently.

Thiz is text without an anchar,

user-defined user-defined description

http:f fwannee, huettenhilfe. defrezept-rote-zwiebeln-vom-grill_249& html

Tags: recipe by you - Edit - Delete (15-06-2009)
Figure 18: Having searched for a specific tag, the descriptions may be edited at the top of
the list.
On the same page, you can apply more actions to the tag:




* Rename the tag - change the name of a tag in all bookmarks of your own collection. That
action does not affect the bookmarks defined by others. It does not affect linked tags
(about linked tags, see Tagging, page 16).

* Delete it - removes the tag from all bookmarks of your own collection. That action does
not affect the bookmarks defined by others. It does not affect linked tags (about linked
tags, see Tagging, page 16).

* Create a link between this tag and another. A link may be an inclusion or simply a
synonym (see Tagging, page 16).

Collaborative descriptions

In traditional social bookmarking tool, users do individual actions which are aggregated by the
systems. Each user has its own bookmarks with their own tags with and their own descriptions.
SemanticScuttle however gives you the opportunity, to define a public description for each
bookmark and tag, respectively. All users can modify these descriptions.

In doing so, SemanticScuttle provides a collaborative space (similar to Wikis) to be negotiated by
users in order to create a common description for each tag and bookmark, respectively.
Together, users can improve the description of a bookmark/tag.

Browser Integration

Using Browser Bookmarks

SemanticScuttle provides a special bookmarklet. It makes it a lot easier to add a new bookmark
to your collection. They automatically add title and address when you add the page. You only
need to enter remaining information.

Bookmarklet
Drag one of the following bookmarklets to your browser's bookmarks and click it whenever you want to add the page you are on to SemanticScuttle:

® Post to SemanticScuttle

s Post to SemanticScuttle (Pop-up)
Figure 19: Adding the bookmarklet to you web browser
You find the bookmarklets when you on the "add bookmark" page. Click "add a bookmark” in the
header of SemanticScuttle and open the "add"” page. Two links are available at the bottom of the

page (see Figure 19). These bookmarklets provide the following functionality. If you click it, the
current web page will be added to your SemanticScuttle collection.

* The first bookmarklet reuses the browser tab/window of the current page.




* The second bookmark opens a new window to define a new bookmark.

Grab the bookmarklet of your choice and drag it into the bookmarks of the web browser. When
you now want to add an open web page to your collection, you simply need to click that
bookmark.

Browser Add-Ons

SemanticScuttle (version > 0.93) supports the Firefox Search bar. If you visit your
SemanticScuttle page, the search bar offers an entry "Add SemanticScuttle" or something
similar. Just click on that entry and from now on you will be able to search in your
SemanticScuttle using the search bar.

Besides: the same feature is available in the Internet Explorer (but we recommend Firefox,
nevertheless).
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The extension for the Firefox web browser makes it easier to use SemanticScuttle.

.

! Opens your bookmarks.

Y

“ Adds the web page in the current tab to your bookmarks.

2 The specific text may vary on different installations of SemanticScuttle.




But before you can start, you need to tell the extension where to find your SemanticScuttle
server. From the menu choose Tools-> Add-ons. The following dialog opens.
Scuttle Options Ii_hj

Installation

Nl Nt o/ decign/scuttle/

Pop-up Window
Width: | 730 pi

Height: | 465 px

| oK | | Abbrechen |

Enter the web address of your SemanticScuttle server and confirm the dialog with "OK". Now you
should be able to use the extension.

Search with Google Custom Search Engine

There are different ways to organize and look into data. For example, Google looks for terms
into documents, Del.icio.us allows to annotate documents with spontaneous tags. These
methods have different advantages which are more or less useful according to the user's task
(find a fact, gathering information...). But why not benefit from all these mechanisms?

SemanticScuttle was founded on tags. In SemanticScuttle (version > 0.89) you can also search
into your bookmarked websites thanks to the Google Custom Search Engine (Google CSE). This
engine is a version of Google restricted to the websites annotated into your SemanticScuttle.

For example, if you install SemanticScuttle into "www.mysite.com/semanticscuttle/" thus you
can find the Google CSE interface into "www.mysite.com/semanticscuttle/gsearch/".



http://www.google.com/coop/cse/
http://www.cs.dal.ca/research/techreports/2005/CS-2005-20.shtml

Part 3: Administration

Install SemanticScuttle

In order to install SemanticScuttle it is crucial that you are familiar with your web server and
MySQL data bases.

New installation
1. File system

1. Download SemanticScuttle from http://sourceforge.net/projects/semanticscuttle/.

2. Create a directory in the folder where your web server stores the published html
files. Unpack the SemanticScuttle files into this folder.

2. Data base
1. Create a data base.

2. Execute the SQL contained in tables.sql to create the necessary database tables.
This file was written specifically for MySQL, so may need rewritten if you intend to
use a different database system.

3. Edit config.inc.php.example and save the changes as a new config. inc.php file in
the same directory (see also the section Configure, below).
4. Make sure that the cache sub-directory is writable. On Linux you need to set the CHMOD

permissions 777.

Upgrade

Since the necessary steps for an upgrade are different in each new release this documentation
does not describe that. There is a file in your SemanticScuttle folder. It gives you detailed
instructions about an upgrade. Look for upgrade. txt.

Configure

All basic settings of SemanticScuttle are stored in the file config.inc.php. The most important
settings are explained here.

The debug mode can be very useful if you encounter problems with SemanticScuttle. You may
switch it on using $debugMode=true. By default, this mode should be off.



http://sourceforge.net/projects/semanticscuttle/

Basic configuration

$sitename

$welcomeMessage = 'Welcome to
SemanticScuttle! More than a
social bookmarking tool.';

Sroot = NULL;

= 'SemanticScuttle'; This is the name of the SemanticScuttle site. You may

just leave the name or specify your own, like "Football
Club Bookmarks". SemanticScuttle will display this
name at the top of the page.

The welcome message is displayed at the top of the
welcome page.

If this is "NULL", SemanticScuttle will try to identify
the address of the web site automatically. If the
installation directory is located in a sub-folder of the
web server, you will have to set it to a specific value in
the format "www.server.domain/subfolder”.

$locale = 'en GB';

$cleanurls = false;

Caching

Susecache = false;

$dir cache =

In this line you define the language. Examples:
* German: "de_DE"

e British english: "en_GB"
*  French: "fr_FR"

Setting it to true forces SemanticScuttle to use URLs
that are better suited for search engine optimization.

SemanticScuttle may use a cache

The default directory for the cache. The cache files

dirname(_ FILE ) .'/cache/';  will be stored there.

Data base settings

$dbtype = 'mysqld’'; Select the data base that shall be used. Valid options
are "mysql, mysqli, mysql4, oracle, postgres, sqlite,
db2, firebird, mssql, mssq-odbc”.

$dbhost = '127.0.0.1"'; Host name (or IP address) of the data base server.

$dbport = '3306'; Database port

Sdbuser = 'username';




$dbpass = 'password';
$dbname = 'scuttle'; Name of the SemanticScuttle data base.

$tableprefix = 'sc_'; All tables in the data base will start with this string.
"sc_" is the default. If the tables are imported with
"tables.sql" (see above) this is the right setting.

User Settings

$adminemail = This email address is important. It allows users to
'admin@example.org'; communicate with the administrator, e. g. when they
lost their password.

$admin_users = array('admin'); All users specified here have special rights.

array('namel', 'name2', 'name3');

Sreservedusers = array('all’', A list of names that are no valid user names. Do not
'watchlist'); remove the given strings. You may add your own ones.

$adminsCanModifyBookmarksFromOt |f ‘true’, admin users can edit or delete bookmarks

herUsers = true; belonging to other users.

Antispam

$antispamQuestion = 'name of SemanticScuttle provides this anti-spam answer. It is
this application (no Caps)'; used because robots may register automatically and

create hundreds of links. If you define your own
antispam question, you can avoid this.

$antispamAnswer = The valid answer to the given anti-spam question.
'semanticscuttle’;

Enable Thumbnails

A thumbnail is a preview image of a web resource. SemanticScuttle may display a thumbnail for
each bookmark (example, see Figure 20).




Tahoo

http:f fyahoo.com
Tags: search, uza, test by admin (11-02-z009)

Google Google
- Google description
http:ff google, com
Tags: search by admin (11-02.2009)

Figure 20: Two bookmarks with a thumbnail in front.

You may activate thumbnails in config.inc.php using $enableWebsiteThumbnails =
false;. If the used service requires a registration, you may also set the required login data
using the variables $thumbnailsUserId and $thumbnailsKey.

By default, Semantic Scuttle uses the service artviper.net. This service is free for non-
commercial projects. The only thing that is required is a link to artviper.net. Commercial
projects need to acquire a license.

It is possible to modify SemanticScuttle to use another thumbnail service, but you have to
change the code. In the file templates\bookmarks.tpl.php there is a line where the artviper
service is called. In release 0.93 (June, 2009) it is line 302:

echo '<img class="thumbnail" onclick="window.location.href=\"'".
$address.'\'" src="http://www.artviper.net/screenshots/screener.php?
url='.$address.'&w=120&sdx=1280&userID=".

SGLOBALS[ 'thumbnailsUserId'].'&hash='.$thumbnailHash.'" />';

You need to change this line according to the requirements of the new thumbnail service.
There are numerous alternatives to artviper, e.g. http://www.mr-thumb.de/ or

http://image.picoshot.com/. On http://akeller.eu/ you may find a more extensive list of
thumbnail providers. Here are the code lines for the given examples:

Picoshot:
echo '<img class="thumbnail" onclick="window.location.href=\"'".
$address.'\'" src="http://image.picoshot.com/thumbnail.php?url=".
$address.';

Mr. Thumb:
echo '<img class="thumbnail" onclick="window.location.href=\"".
$address.'\'" src="http://www.mr-thumb.de/kunterbunt.php

?2url="'.$address.'&size=120" />';



http://akeller.eu/
http://image.picoshot.com/
http://www.mr-thumb.de/
http://www.artviper.net/
http://www.artviper.net/

User and Bookmark Administration

User management. In the admin area, the admins can display a list of all registered users. After
the user name SemanticScuttle displays the number of public, shared, and private bookmarks (in
the given order) of this user. They may remove users. All of the bookmarks will be lost if a user
is removed.

User management

somebody - 171 7 1 bookmark(s)

Delate

tester - 653/ 0/ 0 bookmark(s)
Delete

emailjs - 653 / 0/ 0 bookmark(s)

Figure 21: Overview of all users
and their bookmarks

Checking dead links. The WWW is always changing. You found an interesting page today?
Tomorrow it may be gone. The admin can check all links from all users at once.

Create your own Layout

Unfortunately, there is no easy way to modify the layout of SemanticScuttle. You need to
understand CSS and some image editing tool.

In order to define your own layout you need to change two kinds of resources. The cascading
style sheet and the images used in this style sheet. You may the style sheet scuttle.css in
your SemanticScuttle folder. There is a sub-folder images which contains all the graphical

resources.

The following paragraphs show the html elements with its classes and id's, respectively. If you
change the according entries in the style sheet, you can easily change the layout of
SemanticScuttle.
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Appendix

Glossary

Bot - A bot is a computer program. It searches the web automatically in order to fulfill any type
of task. Search engines (like Google or Bing) use bots to update their "knowledge" about the
web. Other bots may be used for far less decent purposes. Bots may e. g. place links of porn
sites in public bulletin boards or SemanticScuttle.

Browser - A computer program that is used to view Internet resources.

Open Source Software - Open Source Software is software for which the underlying
programming code is available to the users so that they may read it, make changes to it, and
build new versions of the software incorporating their changes. There are many types of Open
Source Software, mainly differing in the licensing term under which (altered) copies of the
source code may (or must be) redistributed. — see WikipediaW

Tag - A tag is a keyword. It represents a topic such as "politics” or "gardening”. This enables
searches for all items with that topic.

URL (Uniform Resource Locator) - An address for a resource available on the Internet.
Friend - in SemanticScuttle a friend is someone on your watchlist.

Tag cloud - A tag cloud provides an overview of a collection of tags. = see WikipediaW
HTML (HyperText Markup Language ) - HTML may be called a certain type of file, because it
defines the structure and layout of a document. More basically, HTML is a language, which
makes it possible to present information on the Internet. — see WikipediaW

XML - XML was designed to transport and store data. XML is similar to HTML. More precisely,
some forms of HTML are a variant of XML. — see WikipediaW

Cookie - A cookie is a small file on your computer. If you visit a web page, this page may save
such cookies. This may be helpful, e. g. to save some settings you made on this page or to
identify you on your next visit.



http://en.wikipedia.org/w/index.php?title=XML&oldid=300013461
http://en.wikipedia.org/w/index.php?title=HTML&oldid=299951561
http://en.wikipedia.org/w/index.php?title=Tag_cloud&oldid=299365528
http://en.wikipedia.org/w/index.php?title=Open_source_software&oldid=299833379
http://en.wikipedia.org/w/index.php?title=Open_source_software&oldid=299833379
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